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FICAM Configuration Guide

HID pivCLASS for OnGuard

The instructions in this document are provided to assist you in configuring a FICAM-compliant

solution using either an HID® pivCLASS® Authentication Module (PAM) or Embedded Authentication

via the LNL-4420 (LNL-X4420) Intelligent Dual Reader Controller.

Note: This document is intended as a help guide only, and is not official documentation from
LenelS2. For any questions, follow your standard method of technical support.

pivCLASS PACS SERVICE

* Configure the pivCLASS PACS Service on page 3

* Configure a PAM in the PACS Service on page 11

PAM DEVICE

* Set PAM to Default [P Address on page 14

e Set PAM to New IP Address on page 15

* Verify New [P Address on PAM Web Page on page 15

OnGuard

* Configure OnGuard to Work with a PAM Device on page 17

* LNL-3300-M5 Setup Information on page 21

* Configure HID Embedded Authentication (LNL-4420/LNL-X4420) on page 22

FIPS 201 Hardware Requirements

¢  For PAM devices with firmware 5.9.xx or later:

- LNL-2220/LNL-X2220, LNL-3300/LNL-3300 with downstream reader modules
* For Embedded Authentication functionality:

Controller
enabled for HID
embedded
authentication Firmware Supported readers
LNL-4420 1.275 or later Onboard readers
LNL-1320 Series 3, LNL-1300 Series 3, and LNL-1300e readers
LNL-X4420 1.275 or later Onboard readers
LNL-1320 Series 3, LNL-1300 Series 3, and LNL-1300e readers
LNL-1324e (Requires OnGuard 7.6)
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Prerequisites

* The following applications need to be installed:

- OnGuard (See Compatibility Charts to determine which version of OnGuard is recommended
for compliance.)

- pivCLASSPACServiceOnGuard.msi Available at http://www.pivcheck.com/lenel
Authentication is required to connect to the pivcheck website. HID Global issues the login
credentials to you when your order is submitted. Note: Refer to the Approved Product List

(APL) published by the Government Services Administration (GSA) to determine which

version of the pivCLASS software is approved with each version of OnGuard.

- FIPS_201_SDK The FIPS 201 SDK license is required for OnGuard enrollment.
*  Only for Embedded Authentication:

- Add-On Auxiliary Module Firmware (These modules are posted at the Partner Center on the
LenelS2 Hardware Firmware Downloads page: https://partnerlenel.com/downloads/
hardware/0/firmware.)

- LNLAUXMOD_AAM.bin (The HID auxiliary module firmware file is required for the
Embedded Authentication solution.) Copy this file to the C:\Program Files (x86)\OnGuard
folder. To remove the HID auxiliary module firmware from the panel, copy
LNLAUXMOD_REMOEV_AAM.bin to the C:\Program Files (x86)\OnGuard folder.

* Ports 1972,4242,8989,10100, 10200, and 11000 should be opened in the Windows Firewall.

Windows Firewall may be disabled but Network Discovery should be enabled (for non-production

environments). Note: This should be done for any ports used by your system.

e OnGuard® Communication Server and Linkage Server are running.

e LSDataCondulT service is running. LSDataCondulT can be run by the Local System account. (This
is the default setting.)

*  After the pivCLASS PACS Service is installed, verify the pivCLASS PACS Service is running, and
then configure it. (Open Windows services from Control Panel > Administrative Tools >
Services. Locate “pivCLASS PACS Service” in the list. Right-click on the service, and then select
Properties. On the Log On tab, select “This account” and configure it the same as the
LSDataCondulT service.)

* Single Sign-On must be configured in OnGuard. (From System Administration, open the
Directories folder from the Administration menu, and then add a directory. In this example,
name the directory “Microsoft Active Directory”. Open the Users folder and link the OnGuard User
to the directory account that has permission to run OnGuard applications and the LSDataCondulT
service.)

* HID license with the following:
- pivCLASS license key
- SDKlicense key
- PAM in Panel license key
- (Optional) IDPublisher license key

Compatibility Charts

Compatibility charts of currently supported OnGuard versions and components are available on the
LenelS2 website: https://partnerlenel.com.
To access the OnGuard Compatibility Charts:
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Sign in to the Partner Center, and then select Downloads.

Choose product or service: OnGuard.

Choose version: Select the version of OnGuard.

Choose type of download: Compatibility Charts.

Open the Third Party Application Compatibility Chart for HID pivCLASS Embedded FIPS-

201 Authentication support.

pivCLASS PACS SERVICE

Configure the pivCLASS PACS Service

1.  Run pivClassPACSServiceOnGuard.msi and install the application.
2. Start the pivCLASS PACS Service application.
3.  Login. The default login credentials are User ID: admi n and Password: passwor d.

Click [Login].

Figure 1. pivCLASS PACS Service Administration

i1y HID Global pivCLASS PACS Service Administration (admir

File Corfiguration ~Maintenance Reports  Help

Credential database summany
Active cards 0
Inactive (suspended)cands 0
Total cards )

> E» [8& @

=4

Background job status

Credential database import ldle
Credential reregistration Idle

4, From the File menu, select License Information, and then enter the license keys. (See

Prerequisites.)

License Manager
pivCLASS license
System D Copy
pivCLASS license key EZE4AM-EVTVH-CFEAE-SHFPT
E xpiration date Newver Expires
Lizensed companents AuaditTrail
Certbanager
Datalmport
FIFS201SDK
|0 Publisher
ReaderServices
Registration
‘Workstation
Fieader Services SDK licenze
SDK license key STHAFZNUZMAZQ Licensed 16716
|DPublizher license
|IDPublizher license key  SFESJISECTVERT Licensed 1000
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5.

6.

From the Configuration menu, select Edit Service Settings to open the Server Configuration
window.

Server Configuration
Application |Users | PACS | PACS [Cont ]| Certificate Validation| TwiC CCL Validation| Certficate Manager | Assurance Profiles| Reader Services|IDPublished
PACS Service paramelers
Server port AUmber
PACS Service TLS parameters
Enetypt communication using TLS
LS key C:\Program Files [+B6)\HID Global\pivCLASS PACS Servicetkeys\PACS Service. ph Browse..

TLS key password Generate...

MUiPACS server parameters

Enable MUliPACS connection

10100 Test Connectivity

Gieneral validation parameters
V| Enable credential validation when a ciedential is registered
/] Check for certificate, CRL, and TW/IC CCL updates every |24 | hours)

Use FASC-N as card identifier for federally issued PIV credentials

Credential database connection

Connection ype Firebird -

V| Store registered credential biometrics in the credential database.

Test... Migrate...

oK ][ cancel || Apply ]

On the Application tab:
Make sure the Server port number is 10100.

a.
b.

The following settings are optional depending on your system:

Enable Credential Validation When a Credential is Registered: Select this option to
validate credential registrations during registration.

Check For Certificate, CRL, and TWIC CCL Updates Every 24 hour(s): Select this
option to specify the pivCLASS software will update its certificates, CRLs, and TWIC CCL
and MD5 files periodically. Select how often the update is to occur in hours.

Connection Type: Select the connection type “Firebird”. Choosing this connection type
pre-configures the default Firebird settings. The Firebird database file is located in the
C:\Program Files (x86)\HID Global\pivCLASS PACS Service\db folder.

Store Registered Credential Biometrics in the Credential Database: Select to store
the fingerprint data in the credential database's Fingerprints table during credential
registration if the credential is registered using a contact interface, and the credential is
unlocked via successful PIN entry. Note: If biometric storage is disabled on a system
that stored biometrics previously, the existing biometric templates are automatically
deleted.

Click [Test] to verify the connection to the database is okay.
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7.  Onthe Users tab: Create a new user. Retain the default values. (“admin” will be added to the list
automatically.)

Server Configuration

|sppiication| Users |PACS | PACS [Cont )| Certficate Validation| TwIC CCL Validation | Certificate Manager| Assuiance Profiles| Reader Services| IDPublisher

Configured users

UserID Name Flole Fingerprints

admin Administratar Administratar Mo

User ID Single Sign-On Enabled

Name

User role -

Password

X X

Verify password

Notes

Clear

ok [ cameel [ Aek ]

8.  On the PACs tab: Browse to the folder where the pivCLASS PACS Service is installed by default:
C:\Program Files (x86)\HID Global\pivCLASS PACS Service\templates\
From here, select the template.xml file.

Server Canfiguration

| spplication| Users | PACS |PACS (Cont,)| Certifieate Yalidation| Tw/C CCL Yalidation| Certificate Manager| &sswance Profiles| Feader Services|IDPublishe]
PACS plug-in parameters

FALS Lenel OnGuard

Template file I-:4Pragram Files (+88)\HID GlobahpivCLASS PACS Servicehtemplateshtemplate. sl Browse.

Propetties

4 Server
Management path \WROCSERVERPC.galab.lenel.com'woot\OnGuard

4 Ciedentials
Username QALAB\Administrator
Password essse

4 General
Suspended badge status Lost
Enable custom field import False

Custom field list [comma-defimited)

Management path

The M| managemant path for DataCondul T. Replace the ' with the remate hostname for iemote connections. Required. Default:
WAoot OnGuard

Validats configuration parameters ]

oK ][ cancel || Apply ]

a. Under Server:

Set the Management path as \\.\root\OnGuard. (Enter a dot “” if OnGuard and PACS
service are installed on a same computer. Otherwise - instead of a dot, enter the full name of
the OnGuard server.)
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b. Under Credentials:
If the PACS Service and OnGuard are installed on the same computer, leave Username and
Password blank.
If OnGuard is installed on a computer different than the PACS Service, enter the Username
and Password of the account used to log into that computer.

c. Under General:
Select “Lost” from the Suspended Badge Status drop-down.
Select “False” from the Enable custom field import drop-down, and then click [OK] to save
the settings.

d. Click [Validate Configuration Properties]. You should receive confirmation that “the plug-in
settings have been validated”.

9.  Onthe PACS (Cont.) tab: Under Events: Select the Send card validation events and Send card
validation failed events check boxes.

Server Configuration

App\icationlUsers PACS | PACS [Cont) |Certiﬂcate Validationl T'wC CCL Validation| Certificate Manager | Assurance Profies | Reader Sewicesl \DPuhIisheri

Data import parameters

Impoirt credential information and assignments
Import PACS credential status
Data Import schedule parameters
9 Run every Kl S [ Minutes
Schedule automatically

User-defined time | 00:00

Events

<

Send card validation events

<

Send card validation failed events

<]

Send reader message events

| Send access granted message events

<]

Send credertial validation emar events

<

Send credential ievoked events

<

Send credertial activated events

0K, ] ‘ Cancel | | Apply
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10. On the Certificate Validation tab:

Server Canfiguration

Application| Users | PACS | PACS [Cont,) Certificate Yalidation | Tw/|C CCL Validation | Certificate Manager | Asswance Profiles| Reader Services \DF’ubhshenI

General parameters

Enable certiicate validation

[ Enforce CHUID expiration nesting
[] Enforce eiiical keplsage extension
[ Enforce key 1D chaining

Ignare C4 revocation unknown [] Ignere invalid name
Ignare CTL signer revasation unknawn ] Ignare invalid policy

|gnare end revocation unknown [] Ignore time not nested

Cartifisate policies and key usages

CPV parameters
CPY timeout €0 + seconds
PV optns Allow unknown G Ignore invalid basic constraints

Ignare CTL time nat valid [7] Ignore raat revacation unknawn

PKI model [crv -
Cotificate checking [ Check optional certificates [] Enforce name chaining
eck signing certificates ave faully certificate paths
[ Check i [ Save faully ceti h

oD Usage  Agency  Typs PVAut. Cadbu. KeyMa. DigtalS

Add Remove

0K

Appl

a. Select the Enable certificate validation check box.

b. Specify the PKI model as “CPV” for revocation status checking.

Set the CPV timeout to 60 seconds and choose the CPV options to be used for certificate

validation.

11. On the TWIC CCL Validation tab: Select the Enable TWIC CCL validation check box.

Server Canfiguration

pplication| Users | PACS | PACS (Cont, )| Certiicate Validation TWIE CCL Validation | Certificate Manager | Asswiance Profies| Freader Serviees| IDPublisher

Gereral parameters

Enable TW/IC CCL validation

TwIC CCL |https: £ funiversalentoll dhs gov/ccl/CCL CSY Browse..
TwC CCL MD5 hitps: Auniversaleroll dhs. gov/ecl/CCL. CSY.MDS

aK

Apply

a. Browse to the server address for checking TWIC cards against the Certificate Revocation

List (CRL): http://twic-crl.orc.com/CRLs.
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b. (Optional) Browse to the server address and MD5 hash address for checking TWIC cards
against the TWIC Canceled Card List (CCL) to verify if the cardholder’s FASC-N has been

canceled.
12. On the Certificate Manager tab:

Server Canfiguration

Certificate manager scheduls

@ Fiun at a spexific time
00:00 7] 1200
[0 o400 [ 1600
[] n=00 ] 20:00
[C] User-defined time 12200 15
[] Scheduls autamatically

) Run after a specific interval has elapsed
4

Certificate manager email alerts

[T] Send emai when Certificate Manager updates card(s]

Dnce per event

Cerlfficate manager paramsters

® Once per ssssion

pplication| Users | PACS | PACS (Cont, )| Certiicate Validation| TwiE CCL Validation) Cerificate Manager |Assuiance Profiles| Freader Serviees| IDPublisher

Update badge in PACS

Disable cards with unknawn status after

72

=| hours

Test

aK

J |

Cancel

J |

Apply

a. Select Run at a specific time to enable running the Certificate Manager at specific times to

re-evaluate all credentials.

b. Select or enter the run schedule for specific times, or schedule re-validation at fixed

intervals.

c. Select Update badge in PACS and Disable card with unknown status after nnn hours.
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13.

Use the Assurance Profiles form to create and update assurance profiles.

Server Canfiguration

Application| Users | PACS | PACS (Cont.]| Certificate Walidation| TwiE CCL Validation| Certificate Manager| Assuiance Profiles |Reader Services| IDPublishe]

Confiqured sssurance profiles

[} Visible
2 Yes
3 Yes
4 Yes
3 Yes

@ 7 Yes
8 Yes
E] Yes
10 Yes
12 Yes
14 Yes
15 Yes
0] Yes

SecuipLevel  Descriplion
Conrolled CAK (TwiE)

Controlled CHUID + BID [TWIC)
Limited CHUID + CAK + BID [TWIC)
Limited PKI+ PIN (FIV)

Exclusion PKI -+ PIN + BIO [P1V)
Conrolled CAK [PIV]

Controlled CHUID + CAK [P1V)

Limited CAK + BID [FIV)

Conrolled Card + PIN (o P¥1)

Limited Card + PIN + BIO (no PKI]
Controlled Secure Messaging (PIV)
Conrolled Assuranee Profile #1

V| This assurance profile
SPE00-116 Security level
Description

Assurance profile 1D

Assurance profile features

may be assigned to configured readers

Azsurance Profile #2
51

Check TWIC Canceled Card List
Match fingerprint

Perform CAK. authentication
Prerform PIY authentication
Perfoim Sk authentication

Unrestricted

Validate CAK certificate

Validate CHUID signature cerificate

Validate fingerpiint template signature certificate
Validate PV certiicate

Validate SM signature certificate

Fik 4o PACS Verfy CHUID
7| Require registration ‘Verify fingerprint template
Fiequire TWIC Ve FIN
SM » CAK fallback
[ cow [ o]
oK | [ el [ Ay |

a. Select the This assurance profile may be assigned to configured readers check box to
include the assurance profile in the drop-down list of assignable assurance profiles of

applicable readers.

b. Select the Require Registration check box to indicate the credentials must be registered
with pivCLASS for access to be granted at the door. If unchecked, the PAM will attempt a
basic Certificate Path Validation (CPV) operation to validate the card's certificates. For this
to succeed, the administrator must load the required trusted root CA and intermediate

issuer CA certificates into

the

C:\Program Files (x86)\HID Global\pivCLASS PACS Service\pam)certs folder.
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14. On the IDPublisher tab:

Server Canfiguration

| pplication| Users | PACS | PACS (Cont,)| Certifieate Yalidation| Tw/C CCL Yalidation| Certificate Manager| &ssuance Profiles | Feader Services| IDPublisher

IDPublisher paramaters
(] Enable [OPUbisher  Port 9030

IDPublisher TLS corfiguration
Encrypt communication using TLS

[7] Require client TLS certificate for mutual authentication

TLS key password

IDPublisher clients

TLS key C:\Program Files (+BS]\HID GlobalpivCLASS PACS Service\keys\PACS S ervics pf

IF &ddiess Description

Add... Hodify... Remove

[ [i3 ][ cancel | [ hppl

Note:

Port: 9090

a0 oo

click [Generate] to generate a key.
15. On the Reader Services tab:

The IDPublisher tab is displayed if the IDPublisher option is licensed,
Select the Enable IDPublisher check box.

Select the Encrypt communication using TLS check box.

Server Configuration

| pplication| Lisers [PACS | PACS (Cont.)| Certlicate Validation| TwIC CCL Validation| Certicate Manager| Assuiance Profies| Reader Services |IDPublisher

Service parameters

Enable XML-RPC 4P| Port 8989
[7] Enable Binary AFI 11000
Enable PAM 5 4PI Port 10200

[T says validate credentials

Fieader Services clients

Fleader Services TLS parameters
[7] Enable TLS encryption
Enable TLS client mutual authentication

C:\Proaram Files [+8B)HID GlobalpivCLAS

Browse Hissystem for TLS key fis

Generate TLS key file:

3/ 16 Reader Services reader licenses

Desciption 1P addiess  Assurance Frofile Fassage
DnGuard o fasssrvems M1128. CHUID [PR) Mo
Add. Modiy. Fremove
[ oK ][ cancel || Apply

a. Select the Enable XML-RPC API check box. Port is set to 8989 by default.

Note:

Cashing Status Proxy Port is the same as the XML-RPC Port.

TLS key: Click [Browse] to select the private key used for securing the TLS connection, or

In the OnGuard® System Administration FIPS 201 Credentials folder, make sure the
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b. Select the Enable PAM 5 API check box with Port set to 10200 (Only for PAM

configuration.)

c. Click [Add] to add a Reader Services client. (This is the computer on which OnGuard is

installed.)

Reader Services Client
Feader Services client parameters

Desciiption

IP address 1011290170

Assurance profils [cHuD P -
FASCN fomat [ 2000 -
LILID format [128:6t LD -]
7] This SDK chent can orly pefom sssurance profls perstions
Ficader Services pivCLASS passage parameters

[7] Use pivCLASS Passage to send Wiegand signal

127.0.01

10001

1

d. In Description, enter a meaningful name for the client.

Enter the IP Address. This is the IP address of the OnGuard computer. Click [OK] to save the
client settings and close the dialog. Click [OK] to save all configuration changes.

f. Ifthe Communication Server is running on a different computer from the OnGuard server
computer, add another Reader Services client with the IP address of the Communication

Server computer.

Configure a PAM in the PACS Service

Note: If the PAM device does not have a valid IP address yet, this can be done later. (For
instructions, refer to PAM DEVICE on page 14.)
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1.

At the PACS Service main window, right-click in the Reader Services window to bring up the
context menu. From the New menu, select pivCLASS Authentication Module 5.x. The Panel

dialog is opened.

Panel
General | Hardware | Reader #1 | Reader H2
Parel parameters
Description
Group
pIvCLASS Authertication Moduls 5.1
MAC addess 00DOG34336FY
IP address 101126423
Last activity timestamp 202041129 15:48:32
Firmware level 51138
Update pansl fimuare
Ping interval &0 + seconds
Comm timeowt n + seconds
Panel Wiegand parameters
Send Wisgand output
[T] Enable keypad passthiough
FASCH output [z00-bi -
LUID / GUID output (1286t uUID -
Keppad output [ Standard [4.bil -
Caching parameters
Enable card cache
Cache size 10000 |2 cards
Cache arace period 28800 |+ [Seconds <
Event buffer size 10000 [ events
Debug parameters
Enable panel debug logging
[ View Iog file. ]
[ Open log file diectory... ]

o0k [ Concel ][ appw

a. Onthe General tab: Enter a name for the PAM in Description. (This name will be also used
in OnGuard). In this example, “TESTPAM” was used.

b. Enter the MAC address of the PAM device. (Later, this PAM device will be configured on its

web page to communicate with the pivCLASS PACS service.)

c. Select the Send Wiegand output, Enable card cache, and Enable panel debug logging

check boxes.

d. Select “200-bit” for FASC-N output and “128-bit UUID” for UUID / GUID output.
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2. Onthe Reader #1 tab: Enter a name for your reader in Description. In this example,
“PKIReader1”.

Panel

| General | Hardware | Reader #1 | Fieader #2

Fieader parameters

V| Enable reader port

Desciption PiReader!

Reader port 1

Authentication type | Assurance Fiofle -
Fsader model [HID pivELASS PKI + PIN Reader -
Assurance profle [cak P -
Feader status Oriis

Rreader version RT3

Freader timeout 10 |5 seconds

Access deried fimeaut 1[5 seconds

Feader relay parameters

Triager relay Never -

Fieader tamper parameters

lanare card reads whils readsr is in tamper state

ok | [ Concel |

Apply

Choose “1” as the Reader port.

Choose an Assurance profile. In this example, “CAK (PIV)".
Use the same steps to add Reader #2.

3. On the Server Configuration > Reader Services tab: Add a new client. (This is the computer
on which OnGuard is installed.)

a
b. Choose “HID pivClass PKI + PIN Reader” or another entry as the Reader model.
C
d

Reader Services Client

Fieader Services client parameters

Deseription DriGu
P address 1011290170

Assurance profile [cHUID PRy - D
FASC:N fomat 2004t -
UUID format [1z8 6 UID -

This SDK. client can onlp perform assurance profile operatiors.
Feader Services pivCLASS passags parameters
Use pivCLASS Passage to send Wiegand signal
127.00.1
10001

1

a. In Description, enter a meaningful name for the client, for example, the name of the
computer where OnGuard is installed.

b. Enter the IP Address of the OnGuard computer.
Note: You may need to configure this as an [Pv6 address instead of an [Pv4 address. You may

discover what needs to be configured later when adding and saving an authenticated
reader in OnGuard. An error would then display reporting the Client “with IPv6 ipaddress”
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10.

is not responding. In this case, copy this “IPv6 ipaddress” and paste it into the IP Address
field for the Reader Services client in the pivCLASS PACS Service.

Select the Assurance profile you want to use.
Select “200-bit” for the FASC-N format and “128-bit UUID” for the UUID format.
Click [OK] to save Reader Service client.

oo oo 0

If the Communication Server is running on a computer different than the OnGuard server,
add this computer as another Reader Services client.

On the Server Configuration > Applications tab and Users tab: Retain the default settings.

On the Server Configuration > On the TWIC CCL Validation tab: Select the Enable TWIC CCL
validation check box.

On the Server Configuration > Certificate Validation tab: Select the Enable certificate
validation and specify the PKI model as “CPV".

On the Server Configuration > Certificate Manager tab: Select Update badge in PACS and
Disable card with unknown status.

From the Configuration menu, select Manage Clients: Click [Add], and then enter the System
ID of the computer where OnGuard is installed.

From the Maintenance menu, select Enable Debug Logging.

Open the Windows services from Control Panel > Administrative Tools > Services. Locate the
pivCLASS PACS service in the list. Right-click on the service, and then select Properties. On the
Log On tab, select “This account” and configure it for the account with permissions to run
OnGuard and LSDataCondulT.
Important:  This step is mandatory in order to work with the LSDataCondulT service on
the OnGuard server.

PAM DEVICE

Set PAM to Default IP Address

Reset the PAM to the factory defaults. This needs to be done to set the PAM to the default IP address:
192.168.0.222.

1.

2.
3.
4

ui

Remove power from the PAM. (Disconnect the power cord/black input attached to power).
Set DIP switches 1 & 8 to ON with the other switches to OFF.
Apply power to the PAM.

Wait until the FAULT, READER 1, READER 2 and RS-485 LEDs flash Red/Green/Red/Green
continuously. This indicates the PAM device is successfully reset to the factory defaults.

Connect the network cable from the PAM to the test computer.

Change the test computer subnet to 192.168.0.0 to configure the PAM:

a. From the Start Menu, select Control Panel, and then Network and Sharing Center.
b. Click on Local Area Network. Select IPV4 > Properties.

c. Select Use the following IP Address and enter the following:
IP address: 192.168.0.10
Subnet mask: 255.255.255.0
Default gateway: 192.168.0.1

d. Click [OK]. Now the test computer will be in 192.168.0.0 subnet.
Remove power from the PAM.

DOC-1123-EN-US (19 May 2020) revision 3 — 14



8.  Set DIP switch 8 to OFF (Leave DIP switch 1 ON).
9.  Apply power to the PAM.

Set PAM to New IP Address

1. Enter the default IP address 192.168.0.222 in a web browser to access the HID PAM
Configuration Tool.

2. Logonto the page: adni n \ password

PivCLASS Authentication Module Configuration

Networking

Signing Certificate
Change Password
Logout

Reboot

3.  Click [Networking] to assign a new IP address for the PAM device.

MAC Address: 00D0694336F9

Canfigure Network: | using DHCP i
using DHCP
using STATIC IP

a. MAC address is displayed and not editable.

b. Configure Network - Choose using DHCP or STATIC IP.
Select using DHCP to configure the PAM to obtain a network address dynamically.
Select using STATIC IP to manually configure - Enter a new IP address for the PAM device.
Also enter the correct Subnet Mask and Default Gateway addresses.
c. Click [Save].
4.  Click [Reboot]. The PAM will reboot. After that, connect the network cable from the network of
the newly assigned IP address.

Verify New IP Address on PAM Web Page

5. In the Command Prompt, ping the newly assigned PAM IP Address to verify the PAM is in the
network.

6.  Enter the new PAM IP address in a web browser to access the HID PAM Configuration Tool.
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7.  Log onto the page: adni n \ password

Networking
PACS Service
Trusted Certificates
Signing Certificate
Change Password
Logout

Reboot

8.  Click [PACS Service].

NOTE: This version of the PAM supports automatic discovery.
To use discovery, turn off DIP switch 1 and the PAM will be found by any PACS Service
on your local network. See the PAM Install Guide for details.

Server Address: 10.112.54.47

PAM 5.x Communication Port Number: | 10200

Save Cancel

a. Enter the IP address of the computer where the PACS Service is installed.
b. Port number: 10200

Click [Save]. A message should display confirming the connection to the PACS Service was
successful.
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9.  Verify the new IP address is now displayed properly for the PAM device in pivCLASS PACS
Service > Reader Services.

s HID Global pivCLASS PACS Service Administration (admin) ===
Eile  Confiquration  Maintenance  Reports  Help
e fSEE
Summary Background job status
Active cards 3 Discovered panels i} Credential validation updates Scheduled to run at 02/01 11:53
Inactive cards i} Online panels 2 Certificate Manager Scheduled to run at 02/01 00:00
Tatal 3 Offline panels i} Credential datebase import Idle
Total 2 Credential reregistration Idle
Data Import Mot scheduled
Reader Services
3 of 16 readers. 16 of 16 embedded readers
Description Type Group Firmware IP address MAC address Timestamp
ETES(PAM PAME <MNone> 511.38 10.112.54.23 00006943363 2020-01-31 14:34:43

OnGuard

Configure OnGuard to Work with a PAM Device

This section includes examples of how to configure a PAM in the OnGuard software. (For more
information on configuring FIPS 201 functionality, refer to “NIST SP 800-116 Support” in the System
Administration User Guide.)

Note: The IP addresses of devices described in this section are provided as examples. You will
need to replace these addresses with actual, working IP addresses.
From System Administration, complete the following steps:
1.  Setup Single Sign-On:
a. From the Administration menu, select Directories. Add a directory, for example “Microsoft
Active Directory.”.

b. From the Administration menu, select Users. Link the OnGuard User to the account in this
directory. This account should have permissions to run OnGuard applications and the
LSDataCondulT service.

Note: The pivCLASS PACS service should also be running under this user account, not the local
account.
2. Make sure the Windows service Smart Card is running. This service is required for OnGuard to

communicate properly with the pivCLASS PACS service.
3. From the Administration menu, select FIPS 201 Credentials.

On the General tab, enter the FIPS 201 SDK License Key in the License Key field. Alternately,
you can simply click on [Download License].

5. On the Credential Validation tab: Keep the default settings, but set the Credential Validation
settings to Validate on Caching Status Proxy.

6.  On the Catching Status Proxy tab:
a. Select “pivCLASS” as the Caching status proxy service.

b. Inthe Server hostname field, enter the IP address (or the full name) of the computer where
PACS Service is installed.

c. 10100 in Port field.
d. Selectall three (3) check boxes in the Enrollment settings section.
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e. Select “Returned” status for the badge status.

f. Enter 8989 (or whatever port number is set for the XML-RPC port in the PACS service) in
the XML-RPC Port field.

g. Click [Test Connection]. A message should display confirming you are “Successfully
connected to Caching Status Proxy server”.
h. Click [OK] to save the settings.
7. On the Authentication Modes tab:
a. Click [Modify].
b. Click [Download] to download all of the authentication modes from the PACS Service. You

will see the list populated with the modes such as CHUID, CAK, CHUID + BIO, etc. No errors
should occur.

8. From the Administration menu, select System Options. On the General System Options tab,
select the Generate software events check box under the OpenAccess host section, and then
click [OK].

9.  Also configure Linkage server host:

a. Browse to the computer where OnGuard is running.

b. Add an access panel, for instance one that supports on-board readers, with the correct IP
Address: 10.112.10.215.
10. From the Additional Hardware menu, select Logical Sources.

a. Addalogical source: In Name, enter “pivCLASS PACS Service” (exactly as it is spelled), select
a World time zone, and then click [OK].

b. On the Logical Devices tab, click [Add], enter “Certificate Manager” in Name, select
“pivCLASS PACS Service” from Logical Source drop-down, and then click [OK].

c. Add the other devices: The PAM (“TestPAM”) and the reader(s). The reader name is
“TestPAM.PKIReader1” which uses the names configured in the PACS Service for the PAM
(“TestPAM”) and the reader (“PKIReader1”).

11. From the Administration menu, select Card Formats.

a. Add a Wiegand card format with Extended ID = 0 - 200. Name this card format. For
example, “Extended 200-bit”".
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Figure 1. Extended ID 200-bit card format

Card Format  Custom Encoding
M ame:
Type:
Facility Code:

Badge Offzet Humber:

Tatal Mumber of Bits On Card:

Facility Code:
Card Mumber:
Extended ID:

lssue Code:

ILS -5 pecific Fields

AD&:
Activate Date:
Deactivate Date:

Autharization:

Mumber of Even Parity Bits:

Mumber of 0dd Parity Bits:

Extended 200 bit

Wwiegand Azzet Format

0 Reversed Bit Order
Duress Format

1]

200 %

Starting Bit: Mumber of Bits:

0 N =

D 0 =

0 200 =

0 = S

0 N =

D 0 =

o | ] o

D 0 =

= Special:

0 - Mone

b. Add a Wiegand card format with Extended ID = 0 - 128. Name this card format. For
example “Extended 128-bit”. Supports PIV-I cards.
Figure 2. Extended ID 128-bit card format

Card Format  Custom Encoding
M ame:
Type:
Facility Code:
Badge Offzet Humber:

Tatal Mumber of Bits On Card:

Facility Code:
Card Mumber:
Extended ID:

lssue Code:
ILS -5 pecific Fields
AD&:

Activate Date:
Deactivate Date:

Autharization:

Mumber of Even Parity Bits:

Mumber of 0dd Parity Bits:

Extended 128 bit

Wwiegand Azzet Format

0 Reversed Bit Order
Duress Format

1]

128 2

Starting Bit: Mumber of Bits:

0 = 0 =

D 0 =

0 128 | =

D 0 =

0 N =

D 0 =

o | ] o

D 0 =

= Special:

0 - Mone

12. Make sure the LSDataCondulT Service is running. If not, start it.
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13.

14.

15.

16.

17.

Add the PAM device as a reader:
a. From the Access Control menu, select Readers and Doors. On the General tab:
b. Add areader with the name “TestPAM.PKIReader1” (where “TestPAM” is a name of the PAM

device configured in the PACS service application and “PKIReader1” is a name of the
reader).

c. Assign these card formats to the reader: Extended 200-bit and Extended 128-bit.

d. Select the Authenticated reader check box, and then assign the reader online and offline
modes. For example, “CAK (PIV)” and “Locked”, respectively.

In Alarm Monitoring, verify that all hardware is online. Change the Reader Access Mode from
“CAK (PIV)” to something else (for example, CHUID (PIV)). The mode should change
successfully. To verify that the communication between the OnGuard server and PACS Service is
correct, go to the PACS Service and make sure the Assurance profile of Reader #1 was changed
accordingly.

Panel

| General | Hardware | Readsr #1 | Reader #2

Fieader parameters

7] Enable reader port

PIReader!
1

Assurance Profile -

HID pivCL&SS PKI + FIN Reader v|

CHUID (PI) -1l

Offling
RBIT3

Fieader tamper parameters

lanare card reads whils readsr is in tamper state

ok H Lancel H Apply

Connect and configure the Omnikey Card Scanner:
a. Make sure the OMNIKEY 3121 Card Scanner is connected via USB to the test computer.

b. Make sure the OMNIKEY 3121 Card Scanner has the latest driver. You can get the latest
driver from the HID Global website. (The OMNIKEY CardMan 3121Scanner was used in this
example.)

c. Addthe OMNIKEY 3121 Card Scanner to the computer and verify it is properly displayed in
Windows > Devices and Printers.

d. Configure the scanner in System Administration. From the Administration menu, select
Workstations. Add the OMNIKEY 3121 Card Scanner as a “PC/SC Encoder”.

In Forms Designer, open the Cardholder form:
a. Click on Last name and select “Last name” from the PIV and PIV-I field options. Click [OK].

b. Click on First name and select “First name” from the PIV and PIV-I field options. Click [OK].
This is done to import first and last names from the card into System Administration.
Important: ~ The corresponding fields must match.

Open the Badge form.

a. Insertanew system object, Extended ID. A text box for Extended ID will now appear on the
Badge form.
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18.

19.

20.

21.

22.

b. Click on Extended ID and select PIV-I to map with “Full GUID (Hexadecimal)” and FASC-N
to map “Full 200-bit FASC-N (Hexadecimal)”.

c. Click on Badge ID and select FASC-N to map with “AC + SC + CN + CS".
d. Click on Deactivation date and select “Card Expiration Date” for PIV and PIV-1.

Save all of these settings. Forms Designer then connects to Application Server and saves all
the settings.

From the Administration menu, select System Options.

a. On the Hardware Settings tab: Set the Maximum badge number length to 18 and
Maximum extended id length to 32 bytes. Save the settings.

Insert the card into the OMNIKEY 3121 Card Scanner to test.

Important:  Before importing the cardholder and card information from a PIV or TWIC
card, the following must be done: certificates registration, verification, and
enrollment of the card into the PACS Service database - proper certificates and
Certificates Revocation Lists (CRLs) should be installed on the computer
where the PACS service is running.

Verify that the certificates and updated CRLs exist on the computer.
Use mmc.exe.

From the Administration menu, select Cardholders.

a. Click [Add], then click [Import].

b. Selectthe OMNIKEY card scanner.

c. Enter 112233 for the password, and then click [Import].
d

In the dialog box, click [Enroll]. This will import the card information into System
Administration. At the end of the process, a message is displayed confirming “Import is
successful”. Click [OK].

e. When asked if you want to keep the default activation dates, click [Yes], and then [OK]. The

new cardholder will be added with their first and last name, extended ID, and deactivation
date from the card.

Add a new access level and assign it to the dual reader interface connected to the PAM with
Timezone configured to “Always”.

Assign this access level to the new cardholder and insert their card in the HID pivCLASS reader
slot. An “Access Granted” event will be displayed in Alarm Monitoring from the reader and
another event from PAM.

LNL-3300-M5 Setup Information

From System Administration, complete the following steps:

1.
2.
3.

From the Access Control menu, select Access Panels.

On the LNL-3300-M5 tab, add a panel of this type with the correct IP Address: 10. 112. 10. 10.
From the Access Control menu, select Readers and Doors. Add a reader configured as follows:
a. Name: PAM M5UL.PivClass Reader 2

b. Type: 8RP Board Reader 1-8
c. Output: F/2F Format

d. Port: Port 2

e. Address: 1
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f. Select the Authenticated reader check box.
4.  From the Additional Hardware menu, select Logical Sources.

a. Addalogical source: In Name, enter “pivCLASS PACS Service” (exactly as it is spelled), select
a World time zone, and then click [OK].

b. On the Logical Devices tab, click [Add], enter “Certificate Manager” in Name, select
“pivCLASS PACS Service” from Logical Source drop-down, and then click [OK].

c. Add the other devices (the PAM and authenticated readers) using their PivCLASS names as

described in a previous step.

Configure HID Embedded Authentication (LNL-4420/LNL-X4420)
1.  From System Administration, configure an LNL-4420 (LNL-X4420) access panel and bring it

online.

2. Copy the HID auxiliary module firmware (LNLAUXMOD_AAM.bin) to the
C:\Program Files (x86)\OnGuard folder.

Note:

To remove the HID auxiliary module firmware from the panel, copy

LNLAUXMOD_REMOVE_AAM.bin to the C:\Program Files (x86)\OnGuard folder.
3. Enable panel-based authentication in System Administration:
a. From the Access Control menu, select Access Panels, and then the LNL-4420 tab.
b. On the Location Tab, select the type of controller (LNL-4420 or LNL-X4420).

c. Onthe LNL-4420 Options sub-tab, select “HID auxiliary authentication” as the Auxiliary
module type, enable TLS encryption, and then click [OK].

I Access Panels ERER
LNL4420 |NL-3300 LNL-2220 LNL-2210 LNL-3300-M5 ACU  LNL-3300GCM NGP/CASI LNL-2000 LNL-1000 LNL500 HID  Other Offine Lock ILS integra ILSOffine  ILS Wircless
Access Panel Workstation Panel type Name:
|RLNL 2420 (54.154)  UMW-OAL-OGT6  INL-4430 LNL-4420 (54.154
TR X4420 (54.33) VMW-QAL-OG76  LNL-X4420
Location  Primary Connection = Secondary Connection Options | Diagnostics MNotes ~ Encryption
Ports Device count
@ re Ports Reader modules: Alam panels
2 R
Feature capacity level. =
3 (Normal)
Store expiration date.
M!m:‘“T Not enforced
16 MB
Store activation date
PIN type: Not e
OSDF biometrics:
HID avodliary aughenticatior
Cardholders:
Assels;
Event capacity: 50000
<
Add Modify Delete Help... [IMudiple Selection 1 of 2 slected Close

4.  From Alarm Monitoring, open the System Status Tree. Right-click on the LNL-4420, and then
select Auxiliary Module Firmware > Download Firmware to download the firmware to the

panel.
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5.

Data Security drop-down.
Figure 3. Set Host Communication to TLS

& > C 0 A Notsecurs | 10.112.54.227

@ G Usited Tachaologies

Home . N
e Host Communication

On the panel's web page, select the Host Comm page, and then select “TLS Required” from the

@ hittpsi//10.11254.227 3

Host Comm Communication
EI [ Use IPv6 Only

Device Info Address:

Load Certificate
OSDP File Transfer

Security Options. : NIC1 v

Diagnostic : 3001

Primary Host Port _ .
Connection Type: Data Security: TLS Required v

Restore/Default ) Authorized IP Address

Apply Settings ® Allow All

Authorized IP Address: l:l

[} Enable Peer Certificate

Required

Alternate Host Port

Connection Type: Disabled v Data Security:

* Select APPLY SETTINGS to save changes.

6.  Select the pivCLASS Embedded Authentication page.

Figure 4. pivCLASS Embedded Authentication Settings

/[ heps/10.11254227 x|
=

&« (&) |A Not secure | b#%://10.112.54.227

¢LENEL
— pivCLASS Embedded Authentication

Host Comm
Device Info

Users Server Address: [10.112 54,16_2_'

I‘ Test Connection ||

Auto-Save

Load Certificate Server Port Address: [l0200] |

SN IO BN [ Enerypt Communication using TLS/SSL
Diagnostic

Restore/Default

Apply Settings Database Location: | Filesystem v

pivCLASS-Embedded-

Version: 5.3.66.117
Patented, www.hidglobal com 'patents

a. Configure Server Address: Enter the [P address of the computer where the PACS Service is

running.
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b. Click [Test Connection]. If a panel with a MAC address of this LNL-4420 is not added yet in
the pivCLASS PACS Service > Reader Services, you will receive a message reporting the
connection is successful, but the panel with that MAC address does not exist.

If this is the case, add the panel in the pivCLASS PACS Service: Right-click in the Reader
Services window to bring up the context menu. From the New menu, select pivCLASS
Embedded Authentication panel. When the Panel dialog is displayed, enter the MAC

address of the panel.

Panel

General

Panel parameters
Description

Group

MALC addiess
IF address

Last activity timestamp

pivCLASS Embedded Authentication
O00FESN72BBE
1011254135

2020-M-23 15:47.57

Firmware level 5935
Update pansl fimuare
Ping interval &0 + seconds
Carnm timeout o + seconds
Reader licerses 16 —
Caching parameters
Enable card cache
Cache size 10000 |2 cards
Cache arace period 28800 |2 | Seconds -
Event buffer size 10000 [ events
Debug parameters
[T] Enable panel debug logging
[ View Iog file. ]

I

Open log file diectory... ]

o0k [ Concel ][ appw

d. Now, in pivCLASS PACS Service > Reader Services, the correct IP address will be displayed

e.

for the LNL-4420/LNL-X4420.

Figure 5. Correct IP Address Shown for LNL-4420

2 HID Global pivCLASS PACS Service Administration (adrmin) (=% B =<=|
File Configuration Maintenance  Reports  Help
e 83
Summary Background job status
Active cards 3 Discovered panels i} Credential validation updates Scheduled to run at 02/01 11:53
Inactive cards i} Online panels 2 Certificate Manager Scheduled to run at 02/01 00:00
Tatal 3 Offline panels i} Credential datebase import Idle
Total 2 Credential reregistration Idle
Data Import Mot scheduled
Reader Services
3 of 16 readers. 16 of 16 embedded readers
Description Type Group Firmware IP address MAC address Timestamp
?4420-135 Embedded <MNone> 5935 10.112.54.135 D00FESD72BES 2020-01-31 14:34:33

Back on the panel’s web page, click [Test Connection] again. You should see this message:

“Settings updated successfully”.
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Return to System Administration. From the Access Control menu, select Readers and Doors,

and then add an Onboard reader to this LNL-4420/LNL-X4420 panel. Configure the Onboard
reader as an Authenticated reader with the online and offline reader modes you require.

Add a Magnetic Card format for Embedded Authentication (LNL-4420/LNL-X4420) readers.

Total characters = 32, Card Number = 15. Name it. For example, “PIV Mag Format”.
Figure 6. PIV Mag Format for LNL-4420/LNL-4420 Embedded Authentication

Card Format  Custom Encoding
Mame: | FIW bag Format
Type: | kagnetic
Facility Code: 0
Badge Offset Mumber: 0

Access Control Track: 2

Access Control Fields on Track 2

Azzet Format

Guest Format

Duress Format

Total Characters on Track 22 32 2 Mirirnurn

Field Length Field Qrder Qffset from Start of
Field: [Pad/Truncate on Left): [0 ==MsA) Track 2
Facility Cade 0= = i
Card Mumber 15 2 3 o
Iszue Code. og = 15
Field Order & Offzet: Contiguous Starting at Beginning of Track 2 [Custom Fields Appended)

Dretermined by Custom Fields

9.  Assign the “PIV Mag Format” card format to the reader.
10. Connectthe HID pivCLASS reader to the reader port of the panel. The LCD screen should display

“Present Card”.

© 2020 Carrier. All rights reserved. All trademarks are the property of their respective owners.
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